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FCC Class B and CE Compliance 

WARNING: This equipment has been tested and found to comply with
the limits for a CLASS B digital device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment gener-
ates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions contained in this manual,
may cause harmful interference to radio and television communications.
However, there is no guarantee that interference will not occur in a par-
ticular installation.

If this equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and
on, the user is encouraged to try to correct the interference by one or
more of the following measures: 1) reorient or relocate the receiving
antenna; 2) increase the separation between the equipment and the
receiver; 3) connect the equipment into an outlet on a circuit different
from that of the receiver; 4) consult the dealer or an experienced audio
television technician. 

NOTE: Connecting this device to peripheral devices that do not comply
with CLASS B requirements, or using an unshielded peripheral data
cable could also result in harmful interference to radio or television
reception.

The user is cautioned that any changes or modifications not expressly
approved by the party responsible for compliance could void the user’s
authority to operate this equipment.

To ensure that the use of this product does not contribute to interference,
it is necessary to use shielded I/O cables. 

This product also complies with European CE requirements.

3



Introduction

Thank you for purchasing the Midiman BiPort 2x4s Serial Port MIDI
Interface. The BiPort 2x4s offers professional MIDI and SMPTE perfor-
mance in an external interface that attaches to any standard PC serial
port, or Macintosh printer or modem port.

The BiPort 2x4s is based on proven Midiman serial port MIDI interface
and SMPTE synchronization technologies.  The BiPort 2x4s has the fol-
lowing features:
•  Cross-Platform:  9-pin mini DIN connector works with both PC and

Mac computers.  The BiPort 2x4s automatically detects connection to
a PC or Mac.

• Operates as a MIDI interface and a stand-alone SMPTE
reader/writer/regenerator.

• Four independent MIDI Outs and two MIDI Ins provide 64 channels
of MIDI output and 32 channels of MIDI input.

• Large high-performance data buffers ensure full MIDI throughput
with no data loss.

• Built-in SMPTE Time Code reader/writer/regenerator supports all
standard time code formats (24, 25, 29.97, 30-drop, 30 non-drop), and
is completely controllable via Front Panel pushbuttons and the
included Remote Control software.

• Supports SMPTE User Bits, set by incoming SMPTE or by Remote
Control software.

• Adjustable SMPTE flywheel and Jam Sync.
• “Mac Thru” switch allows you to activate or bypass the unit so you

can retain your Mac modem or printer connection.
• Windows and MacOS drivers included.
• Drivers are multi-client and support full MIDI bandwidth on all

ports — even when using multiple programs.  Multiple BiPort 2x4s
units may operate simultaneously.

• Industry standard MME compatible for the PC, OMS compatible for
Mac.

• Apple Geo-Port compatible.
• Compact size.
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IMPORTANT NOTE!

Please thoroughly read and follow the installation instruc-
tions before physically installing your BiPort 2x4s. For Macs
and PCs, a factory diskette containing diagnostic software,
drivers and a Remote Control application are included with
your BiPort 2x4s. To install these programs, read this manu-
al and carefully follow the installation procedures.  

If you have any questions, comments, or suggestions about BiPort 2x4s
or any MIDIMAN product, we invite you to contact us directly at:

MIDIMAN
45 E. Saint Joseph Street
Arcadia, CA 91006-2861

Technical Assistance: (626) 445-8495
E-mail: techsupt@midiman.net
Fax: (626) 445-7564
World Wide Web:   www.midiman.net
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Package Contents

Included in the BiPort 2x4s package should be:
• The BiPort 2x4s interface unit.
• 8-pin Mini-DIN to DB-9 Serial cable for PC.
• 8-pin Mini-DIN to 8-pin Mini-DIN Serial cable for Mac.
• DC 9 volt, 500 mA power supply (US only).
• This instruction manual.
• A drivers, applications and diagnostics diskette for both Mac & PC.

Front and Back Panel

Front Panel
1. MIDI In-A Connector - For MIDI Input channel A, the first MIDI

input of two.
2. MIDI Out-A Connector - For MIDI Output channel A, the first MIDI

output of four.
3. MIDI In and Out LEDs - Indicate MIDI Input and Output activity on

the 6 MIDI ports.
4. Write button - Starts and stops the SMPTE writer, sets the Write

Offset time.
5. “Locked” and “Writing” LEDs - The “Locked” LED indicates SMPTE

reader/regenerator status;  the “Writing” LED indicates SMPTE
writer status.

6. Format button - Manually selects the format of SMPTE Output.  Push
repeatedly until the proper format is set.

7. SMPTE Format LEDs - Indicate the current SMPTE output format.
“24” indicates 24 fps (frames per second), “25” indicates 25 fps, “DF”
indicates 30 fps drop-frame, and “30” indicates 30 fps or 29.97 fps in
special cases.

8. Mac Thru button - Selects whether host data is routed to the BiPort
circuitry, or instead by-passed directly to the Mac Thru port.

9. Mac/PC LEDs - Indicate whether the BiPort is connected to a Mac,
PC, or by-passed (Mac Thru). 

In-A 24
Write

DF 30

25 Mac
Thru

PC

In-A

Locked

Writing

Format

Out-A

Out-A Out-C

In-B Out-B Out-D

Thru MIDI

Mac

1 2 3 4 5 6 7 8 9
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Back Panel

10. Power Connector - Accepts power from the 9 Volt DC 500 mA power
supply included with your BiPort 2x4s. If you ever need to replace
this power supply, make sure that it will supply at least 500 mA and
has the center pin positive.

11. Host In - Connects to the serial port of the host computer.  For the
PC, it connects to a standard serial (COM) port; for the Mac, it con-
nects to the serial or printer port.

12. Mac Thru - Connects to a modem or printer that would normally be
connected to the serial or printer port of your Macintosh. 

13. SMPTE In - Receives SMPTE time code from a tape deck or other
SMPTE source.

14. SMPTE Out - Outputs SMPTE time code to a tape deck or other
SMPTE device.

15. MIDI In-B Connector - For MIDI Input channel B, the second MIDI
input of two.

16. MIDI Outs B, C, and D - For MIDI Output channels B, C, and D (2nd,
3rd and 4th outputs of 4).

Theory of Operation

The BiPort 2x4s may act as a stand-alone SMPTE reader/writer/regener-
ator, or MIDI/SMPTE Interface to a host computer.  When first powered
up, the BiPort 2x4s will assume the Stand-Alone mode.  In order to enter
MIDI Interface mode, the BiPort 2x4s must be connected to either a Mac
or PC host; the host computer drivers will contact the BiPort 2x4s and
configure it for MIDI Interface mode.   When the host is done using the
BiPort 2x4s in Interface Mode, you may command the BiPort 2x4s back
to Stand-Alone mode by exiting all MIDI applications.

Stand-Alone Mode

When first powered up, the BiPort will assume Stand-Alone mode.  In
this mode, the BiPort operates in a similar fashion to the Midiman
SyncmanTM and other dedicated sync devices.  It is also the mode in
which Mac Thru should be selected if desired.  In Stand-Alone mode, the

9VDC

SMPTEHost
In

Mac
Thru OutIn

Out-DOut-COut-BIn-B

10 11 12 13 14 15

16
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BiPort performs the following functions:
• Acts as a SMPTE writer.  The user may manually configure, start and

stop the SMPTE writer from the BiPort’s front panel.  The SMPTE sig-
nal appears at the SMPTE Out jack.

• Acts as a SMPTE reader/regenerator.  If the BiPort is not writing
SMPTE, whenever a valid SMPTE signal appears at the BiPort’s
SMPTE In, the BiPort will synchronize with and read the incoming
SMPTE signal.  It will also automatically regenerate SMPTE to the
SMPTE Out jack.

• Outputs MIDI Time Code (MTC) on MIDI Out-A.  Whenever the
BiPort is reading or writing SMPTE it will convert the SMPTE infor-
mation to MTC.  The MTC will exit the BiPort at MIDI Out-A.

• Monitors MIDI In-A for SYSEX information from an external source.
An external MIDI device may use SYSEX commands to configure,
start and stop the SMPTE writer.

• Acts as a “thru box” for Mac printer or modem operation.
• All front panel buttons are active in this mode.  Only MIDI ports In-A

and Out-A are active.

MIDI Interface Mode

When connected to a PC or Mac host computer, the BiPort may be com-
manded into Interface Mode by that host computer by launching a MIDI
application that utilizes the BiPort driver.  When it does, it will indicate
the host type by lighting either the “MAC” or “PC” LED on the BiPort
front panel (these will light in Stand-Alone mode when accessing the
Remote Control software).  As an interface, the BiPort 2x4s acts very sim-
ilar to the Midiman Portman 4x4/STM and other MIDI/SMPTE interfaces.
In MIDI Interface mode, the BiPort performs the following functions:

• Acts as a 2-input 4-output MIDI interface.  Data is routed between
the host and all MIDI ports simultaneously.  Each port is capable of
independent 16-channel MIDI operation.

• Acts as a SMPTE writer.  The SMPTE writer may be configured, start-
ed and stopped by either the front panel controls or by Remote
Control software. The SMPTE signal appears at the SMPTE Out jack.

• Acts as a SMPTE reader.  Similar to Stand-Alone mode, the BiPort
monitors incoming signals at the SMPTE In jack and locks to it when-
ever valid code is detected. 

IMPORTANT:  In order to guarantee full MIDI bandwidth on
all ports and accurate SMPTE regeneration, Interface Mode
does not regenerate incoming SMPTE.  Only Stand-Alone
Mode regenerates SMPTE.
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• Outputs MIDI Time Code (MTC) to the host.  Whenever the BiPort is
reading or writing SMPTE it will convert the SMPTE information to
MTC.  This MTC is transmitted to the host computer via the host seri-
al cable.

• Monitors the host port for SYSEX control information.  This is where
commands from the Remote Control software are received.

Functions Shared by Both Modes

Most BiPort functions are available in both MIDI Interface and Stand-
Alone modes.  This section describes the operation of each of these
“common” functions.

SMPTE Writer

The SMPTE Writer generates continuous SMPTE and MIDI Time Code.
While writing SMPTE, the “Writing” LED is always illuminated.  The
writer may be configured, started and stopped either manually (see
“Write” Button section) or via software.  The writer configuration
includes SMPTE output format, start offset, and User Bits.  The power-
on defaults for these parameters are 30 fps, 01:00:00:00, and 00 00 00 00,
respectively.

Important: Powering down the BiPort 2x4s will reset all
internally-stored values to their factory defaults.

When the SMPTE Writer is running, the SMPTE reader is disabled.  In
fact, the SMPTE writer may override the SMPTE Reader at any time.
While the writer is running, the front panel “Format” button is also dis-
abled.  The writer must be stopped before the output format may be
changed.

The Writer is capable of generating SMPTE in five formats: 24fps, 25fps,
29.97fps, 30 drop-frame and 30 non-drop.  The 29.97fps format is only
accessible via the Remote Control Software.  It is displayed on the front
panel “Format” LEDs as 30fps.

SMPTE Reader

The SMPTE Reader locks to incoming time code, regenerates it to
SMPTE Out (regeneration occurs only in Stand-Alone mode), and con-
verts it to outgoing MIDI Time Code.  The SMPTE Reader is capable of
automatically detecting the incoming SMPTE format.  When it does, it
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displays the format to the “Format” LEDs on the BiPort front panel.
Automatic format detection will take between 3 and 31 frames, depend-
ing on the incoming format and the value of the first SMPTE frame
received.  When using the BiPort with a sequencer program synced to
MIDI Time Code, at least 3 to 5 seconds of pre-roll are recommended for
proper synchronization.

Once locked, the SMPTE Reader lights the “Locked” LED.  Whenever
invalid incoming SMPTE is detected, the “Locked” LED will blink for
approximately 0.25 seconds for each bad frame, or until flywheeling has
completed.

The SMPTE Reader may be configured only via software.  The reader
configuration includes the flywheel setting, which has a power-on
default setting of 15 frames.  It may be adjusted to jam sync as well as
flywheel - jam sync is equivalent to a flywheel setting of 0 frames (see
the section “SMPTE/MIDI Time Code Tutorial” later in this manual).

Important: Powering down the BiPort 2x4s will reset all
internally-stored values to their factory defaults.

The SMPTE Reader is capable of decoding User Bits from the incoming
SMPTE stream.  The most current User Bits are stored to the BiPort inter-
nally and may be used later during SMPTE writing.

SMPTE “Write” Button

The SMPTE “Write” button has two purposes: 1) to manually control the
SMPTE writer, and 2) to stop the SMPTE Reader when it is performing a
“jam sync.”  When the “Write” button is pressed and immediately
released, SMPTE time code starts writing at the preset start offset.  The
SMPTE Writer will continue to run until the “Write” button is pressed
again.  The “Write” button may also be used to change the start offset.
To manually increment the start offset, press and hold the “Write” but-
ton — this will increment the stored start offset by 1 hour every time the
“Write” LED blinks.  The blinking occurs approximately once a second.
Release the “Write” button to begin writing at the new offset.  

When the SMPTE reader is performing “jam sync,” it will continue to
run indefinitely.  However, this may be aborted by pressing the “Write”
button.
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SMPTE “Format” Button

The “Format” button is used to select the SMPTE output format.
Repeatedly pressing this button will cycle the unit through the four
SMPTE formats displayed on the front panel LEDs.  This button is inac-
tive if the BiPort 2x4s is currently reading or writing SMPTE.

“Mac Thru” Button

The “Mac Thru” button selects whether host data is routed to the BiPort
circuitry, or instead by-passed directly to the “Mac Thru” port.  To
bypass the BiPort circuitry, set the button to the “Thru” position by
pushing it until it latches in.  Setting the BiPort to the “Thru” mode will
make the BiPort transparent to the Mac; the Mac may communicate
directly with a modem or printer that is attached to the “Mac Thru” port
on the back panel of the BiPort.

NOTE:  The Mac Thru function does not work with PC com-
puters and peripherals.  It is intended for use with Mac
computers only.

To make the BiPort available for communication with a host computer,
set the button to the “MIDI” position by pushing it until it latches out.
When set to this mode, any external device attached to the Mac Thru
port is disabled from communicating with the host computer.

NOTE:  In “Thru” Mode, the BiPort can only act as a stand-
alone unit.  To indicate that it is “crippled for interface use”
during this mode, the BiPort continuously and alternately
lights the “MAC” and “PC” LEDs on its front panel.
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Typical Stand Alone Setup - Fig. 1
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BiPort 2x4s INSTALLATION

Installation for Stand-Alone Mode

A typical stand-alone system set-up (see Fig. 1) might consist of a BiPort
2x4s, a tape deck, and a hardware MIDI sequencer.  This set-up is con-
nected as follows: 

• The tape recorder Tape (or Sync) Out is connected to the BiPort 2x4s
SMPTE In. 

• The tape recorder Tape (or Sync) In is connected to the BiPort 2x4s
SMPTE Out. 

• The BiPort 2x4s MIDI Out-A is connected to the MTC (or MIDI) In of
the MIDI sequencer. 

In this example, the BiPort 2x4s serves several functions: 1) it synchro-
nizes the MIDI hardware sequencer to the tape recorder by converting
the tape recorder’s SMPTE signal into MIDI Time Code for use by the
sequencer; 2) it acts as a stand-alone SMPTE striper for writing a SMPTE
track to the tape recorder.  The BiPort 2x4s’ front panel pushbuttons are
used to manually configure and control the BiPort.

Before connecting each piece of equipment, it is a good idea to verify
that each piece is powered down.  After all connections are made, apply
power to each device once again.

Installation for MIDI Interface Mode

A typical MIDI interface system set-up (see Fig. 2) consists of a BiPort
2x4s, a host computer, your sequencing software, a tape deck, a master
MIDI keyboard, and additional MIDI sound modules or keyboards.
This set-up is connected as follows: 

• The BiPort 2x4s Host In is connected to the serial port of a host com-
puter, using one of the supplied serial cables.  See following sections
for more information.

• The BiPort 2x4s Mac Thru button is latched in the “out” position so
that the BiPort 2x4s may communicate with the host computer.

• BiPort 2x4s MIDI In-A is connected to MIDI Out of your MIDI master
keyboard.

• BiPort 2x4s MIDI Out-A is connected to MIDI In of your MIDI master
keyboard.

• The tape deck Tape Out (or Sync Out) is connected to the BiPort 2x4s

13



SMPTE In. 
Typical MIDI Interface System 
Set-up - Fig. 2
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• The tape deck Tape In (or Sync In) is connected to the BiPort 2x4s
SMPTE Out. 

• Additional MIDI devices may be directly connected to the BiPort
2x4s MIDI In-B, MIDI Out-B, MIDI Out-C and MIDI Out-D jacks. 

In this example, the BiPort 2x4s provides several functions: 1) it acts as a
multi-port MIDI interface between the host computer and the connected
MIDI keyboards and sound modules;  2) it synchronizes the host com-
puter to the tape recorder by converting the tape recorder’s SMPTE sig-
nal into MIDI Time Code for use by the host’s MIDI sequencer applica-
tion;  3) it acts as a  SMPTE striper for writing a SMPTE track to the tape
recorder.  While connected to the host computer, the BiPort 2x4s may be
controlled by either the front panel pushbuttons or by Remote Control
software running on the host computer.  Before connecting each piece of
equipment, it is a good idea to verify that each piece is powered down.
After all connections are made, apply power to each device once again.

NOTE: The BiPort 2x4s may be left attached to a computer
that is turned off.  However, the BiPort 2x4s should always
be powered up before the computer.  The BiPort-to-Host
serial cable should not be connected or disconnected while
either is powered up.

In order for MIDI Interface mode to properly operate, there are addition-
al steps that must be taken to configure the host computer.  Each of these
steps is only required once.  After that the host computer will remain
configured for operation.  The steps in configuring the host computer for
MIDI Interface mode are:

• Selecting a PC or Mac host serial port and connecting to it.
• Running the included diagnostic software to ensure reliable connec-

tion between the BiPort and the host computer.
• Installing the provided software drivers on the host computer.
• Installing the Remote Control software.
• Configuring the host MIDI application(s) to use the BiPort 2x4s as its

MIDI interface.

Each of these steps is described in its own section that follows.

BiPort to Host Connection

There are two steps to physically connecting the BiPort 2x4s to your host
computer:  1) selecting the host serial port, and 2) connecting the BiPort
to the host with the proper cable.
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Selecting a PC Host Serial Port

In order to operate as a PC MIDI Interface, the BiPort requires connec-
tion to a PC serial port.  PC serial ports are also known as “COM” ports.
The COM port configuration for each computer varies.  Most computers
have one or two COM ports, and some are configured to have 4 or more.
Windows knows these COM ports as “COM1”, “COM2”, “COM3”,
“COM4” and so on.  Serial ports are usually male (pins sticking out) DB-
type connectors, and can have either 9 or 25 pins.  Sometimes a COM
port will not actually be present at the rear of your computer; it may
instead be used internally by a modem or other device.

The COM ports on the back of your computer might be labeled 1 and 2,
or A and B.  If not, you should check your computer manual to verify the
actual configuration.  If you have a modem in your system, you should
check to see what COM port it is using.  A simple way to do this is to go
to the Control Panel, open the Modems icon, and click Properties.  

NOTE:  Usually odd numbered COM ports share the same
IRQ as COM1, and even numbered COM ports share the
same IRQ as COM2.  All COM ports use different I/O
addresses.  

Although the IRQ and I/O address (also referred to as Input/Output
range) are fairly standard, you may view these settings within Windows
by going to the Control Panel, opening System, and clicking Device
Manager.  Open the Ports list by clicking the plus sign, click the Com
port, click Properties, and then click Resources.

Try to select a COM port for BiPort use that does not use the same IRQ
as some other installed device.  Also, select a COM port that is not being
used by a mouse or modem.

Selecting a Mac Host Serial Port

In order to operate as a Mac MIDI Interface, the BiPort requires connec-
tion to one of the Mac serial ports.  The BiPort may be connected to
either a modem or printer port of the Mac.  Either port may be used -
just be sure the MIDI program you are using is set to use the same port
you have your BiPort 2x4s connected to. 
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About the Serial Cables

The BiPort 2x4s ships with two cables for connecting the BiPort to a host
computer.  One cable connects the BiPort to a standard PC serial port
connector (male 9-pin DB-type); the other connects the BiPort to either a
Macintosh modem or printer port.  Both cables are standard configura-
tion cables that can be found in most computer supply stores.  If your
PC has a 25-pin DB connector serial port instead of a 9-pin version, you
can purchase an adapter that will accommodate the 25-pin connector at
your local computer store.

Diagnostics Software

After the BiPort 2x4s is connected to the host computer, you can ensure
reliable connection between the BiPort and the host computer by run-
ning the included diagnostic software.

PC Diagnostics Application

The included PC diskette contains the BI24DIAG.EXE diagnostic pro-
gram.  It is intended for testing the BiPort-to-PC connection.

Note:  The PC diagnostic program may be run from either
the “true” DOS prompt, or from a DOS box in Windows.   It
will not operate on a Mac computer.

To run the program, insert the MIDIMAN diskette into your computer’s
disk drive.  Verify you are accessing the proper disk drive by typing
either “A: <Enter>” or “B: <Enter>” at the DOS prompt.  This should
give you either the A:\> prompt, or B:\>, depending on which drive let-
ter represents your 3.5” floppy drive.   Once you see this prompt, type
“BI24DIAG” and press the <Enter> key. 

Once in the diagnostic program, you can press your computer’s <Enter>
key to toggle through the COM Port setting until it matches your setup.
As you select your COM port, the program will automatically setup the
standard I/O address and IRQ for that COM port.  This will work for
nearly all systems.  Occasionally custom-configured computers will
require tweaking of the Address and/or IRQ settings.  To change these,
use the <up> and <down> cursor keys to select the Address and/or IRQ
Number, then <Enter> to change that parameter’s setting.
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Next, connect a single MIDI cable from BiPort MIDI In-A to MIDI Out-A
(the front two MIDI jacks) of the BiPort 2x4s.  This cable will be used to
“loop back” MIDI data - the BiPort will transmit MIDI data from Out-A
and receive/verify it at In-A. 

IMPORTANT: When performing this test be sure that BiPort
MIDI In-A and MIDI Out-A are connected properly with a
standard MIDI cable.  Otherwise the diagnostics program
will indicate that your unit is failing the test.

Now connect the SMPTE In jack to the SMPTE Out jack using a single
standard male-to-male 1/4” phone cable. This cable will be used to
“loop back” and verify SMPTE data.

Move the cursor down to the “Run Tests” line and press <Enter>.  The
program should run through five separate tests.  If any of these tests fail,
go back and make sure that you have followed the setup instructions
exactly.  Once the first run of tests has passed, toggle the settings on the
“Loopback” line of the diagnostics screen to verify other MIDI input and

1
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output ports. Move the connecting MIDI loopback cable to match the
setting on the diagnostic program screen and re-run the tests to make
sure that all of your BiPort inputs and outputs are working properly. 

Mac Diagnostic Application

Included with your BiPort 2x4s is Remote Control and Diagnostic soft-
ware that enables you to configure and control your BiPort 2x4s SMPTE
functions directly from your computer, as well as the diagnostic test for
basic BiPort functionality.  The diagnostic test for Macintosh is contained
within the Remote Control software.

To install the BiPort 2x4s Remote Control & Diagnostic application onto
your Macintosh, first insert the disk entitled “BiPort 2x4s Mac Drivers &
Remote Control Software” into your floppy disk drive.  When the disk
icon appears, double click on it.  Next, locate the file “BiPort Remote”,
click on it and drag it onto your hard drive.  Double clicking on the
BiPort Remote application from your hard drive will then open the
BiPort 2x4s Remote Control.

Open the Select Menu, then click Diagnostics.  This will bring up the
BiPort diagnostic test for Macintosh computers.   Running the test is
almost identical to running the test for the PC, as described on pages 18-
20 in your BiPort manual.  The Diagnostic test page will show you the
Device Port that the BiPort is connected to, the “Loopback:” test that will
be performed with a dropdown menu to select other configurations (the
default is Out A to In A), plus a “Passes” list that allows you to select
how many times the diagnostic will run (the default is 1 pass).

To perform this test you must create a MIDI “loopback” by taking one
MIDI cable and plugging one end into Input-A, and the other end into
Output-A (as illustrated on page 18).  Also, a single standard male to
male phone cable must be plugged in-between the SMPTE In and Out
on the BiPort’s back panel (also shown on page 18).  Once this has been
done, click the “Run Tests” button.  This will perform a series of 5 tests
described on pages 19 and 20 of the manual.  Refer to these pages and
the troubleshooting guide if your unit fails any of these tests.

To test the functionality of other MIDI ports on the BiPort, pull down the
“Loopback:” menu and select another configuration, e.g. Out B to In B.
You will now need to plug your loopback MIDI cable from Input B to
Output B (in this case).  Once again, click Run Tests.
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Test Results for Mac or PC

Below are brief descriptions of each test phase:

1.  Internal Hardware Test

This test verifies the BiPort-to-host connection.  If the connection is
working properly, the test will display “PASS” and return the BiPort’s
internal firmware revision number.  Write this revision number down in
case you ever need to contact Midiman Tech Support.

If your BiPort fails this test, it could mean a bad BiPort or other hard-
ware failure, but most often it means one of a few very specific things:

• You have selected the incorrect port settings in the diagnostic pro-
gram.

• BiPort power is not properly connected.
• Your serial cable is not compatible or is defective.
• Your computer’s serial port is configured incorrectly, is defective or

disabled. There may be an infrared function available for the serial
port, and it is enabled. You should disable the infrared function via
the BIOS CMOS Setup of your computer’s motherboard

2.  Internal Buffers Test

This test verifies the BiPort-to-host connection, as well as the BiPort’s
internal MIDI data buffers.  If it fails, it most often is due to one or more
of the following:

• Your serial cable is not compatible or is defective.
• Your computer’s serial port is configured incorrectly, is defective or

disabled.  There may be an infrared function available for the serial
port, and it is enabled.  You should disable the infrared function via
the BIOS CMOS Setup of your computer’s motherboard

• The BiPort is defective. This is extremely rare as the BiPort units are
tested rigorously at the factory before shipping.  If you think this is
the case, please contact MIDIMAN Technical Support.

3.  Transmit/Receive Test

This test verifies the BiPort’s ability to transmit and receive MIDI data
on its ports.  If it fails, it most often is due to one or more of the follow-
ing:
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• The loopback MIDI cable is incorrectly connected.  Check to make
sure that you have a MIDI cable connected between the BiPort MIDI
In and the BiPort MIDI Out selected in the diagnostic program. There
should be no MIDI instruments, mergers, or thru boxes connected to
the BiPort during this test; it is a closed-loop test with one MIDI cable
connected between two MIDI jacks of the BiPort.

• The MIDI cable you are using to loopback data is defective.
• The BiPort is defective. This is extremely rare as the BiPort units are

tested rigorously at the factory before shipping.  If you think this is
the case, please contact MIDIMAN Technical Support.

4.  Receive Interrupt Test

This test verifies the reception of data from the BiPort under interrupt
(IRQ) control.  If this test fails, it is host serial port related.  More specifi-
cally it is almost always host IRQ-related.

Most computers use IRQ4 for COM1 and IRQ3 for COM2.  If you have
the BiPort connected to COM1 on your computer and have IRQ=4 set in
BI24DIAG.EXE, but it fails the Receive Interrupt Test, you could have an
internal modem connected COM1 or another odd numbered COM port
using the same IRQ.  Another possibility is a driver associated with
another device used on the same serial port is adversely affecting the
IRQ.  Yet one more possibility is that your serial port IRQ is disabled in
your computer’s BIOS CMOS setup, and simply needs to be switched
on.

If you are unsure what your port IRQ is or how to find out, please see
the section in this manual titled “Selecting a Host Serial Port,” or consult
your computer owner’s manual or computer manufacturer directly.

5.  SMPTE I/O Test

This test makes sure that the SMPTE In and Out jacks are functioning
properly.  If this test fails, make sure that the cable you have looped from
SMPTE In to SMPTE Out is good, and also properly connected.

PC Drivers and Driver Installation

MIDI application software communicates with the BiPort 2x4s via soft-
ware “drivers.”  Basically, a Windows software driver is a special dedi-
cated program that makes a MIDI interface accessible to any Windows
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application.  On the included software diskette, Midiman supplies the
Windows drivers that enable the use of the BiPort 2x4s with Windows
MIDI applications.

In order to communicate with the BiPort 2x4s, the Windows driver
needs know what serial (COM) port you are connecting to the BiPort
2x4s.  The BiPort driver is smart enough to detect which COM ports are
installed in your system.  This helps you to select the proper one from
the “COM Port” list box.  You also have the option of disabling the
BiPort driver, which is handy if you would like to leave the driver
installed while the BiPort hardware is not physically connected to your
system.

Windows 98 Installation

1. From the Windows98 Start menu, select Settings | Control Panel |
Add New Hardware. 

2. Select the Next> button.
3. Once again, select the Next> button.  The system will now search for

Plug and Play (PnP) hardware.
4. If Windows does find one or more PnP devices, select No, the device

isn’t in the list and select Next>.  (The BiPort 2x4s is not PnP and will
never show up in this list.)

5. Windows then asks if you would like it to search for the new hard-
ware.  Select “No, I want to select the hardware from a list” and press
the Next> button.

6. Windows wants you to select the type of hardware you are installing.
Scroll down the list and highlight Sound, video and game controllers.
Then click on Next>.

7. When the next dialog appears, click on the Have Disk... button.
8. Insert the “BiPort 2x4s Drivers and Diagnostics” diskette in Drive

A:\ and click on OK.  If you must use drive B: instead, insert the
diskette in drive B: and select B:\ before clicking OK.

9. When the next dialog appears, click on OK to the BiPort 2x4s.
10. When the next dialog appears, click on Finish.  Windows will copy

and install the Windows driver files.
11. Next you will be prompted for the BiPort 2x4s setup.  The driver

COM Port setting defaults to Disable.  Click on the arrow to select the
proper COM port. Click on OK.

12. Your BiPort drivers are installed!
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Windows 95 Driver Installation

1. From the Windows95 Start menu, select Settings | Control Panel |
Add New Hardware. 

2. Press the Next> button.
3. Click radio button No because you do not want Windows to search

for new hardware.  Click on Next>.
4. Scroll down in the box and select Sound, video and game controllers.

Click on the Next> button.
5. Click on Have Disk... button.
6. Insert the “BiPort 2x4s Drivers and Diagnostics” diskette in Drive

A:\ and click on OK.  If you must use drive B: instead, insert the
diskette in drive B: and select B:\ before clicking OK.

7. When the next dialog appears, click on OK to the BiPort 2x4s.
8. When the next dialog appears, click on Finish.  Windows will copy

and install the Windows driver files.
9. Next you will be prompted for the BiPort 2x4s setup.  The driver

COM Port setting defaults to Disable.  Click on the arrow to select the
proper COM port. Click on OK.

10. Your BiPort drivers are installed!

IMPORTANT:  If at a later time you encounter problems
using the BiPort 2x4s with Windows, verify that Windows
has loaded the BiPort 2x4s driver.  The BiPort appears in
the Device Manager, under Sound, video and game con-
trollers.  To verify that the driver is loaded, from the
Windows98 (or Windows95) Start menu, select Settings |
Control Panel | System | Device Manager.  You should see a
Midiman BiPort 2x4s entry under Sound, video and game
controllers (you may have to click on the “+” sign to display
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the devices under Sound, video and game controllers).  The
BiPort outputs will also show up under Settings | Control
Panel | Multimedia | MIDI, as well as the MIDI Devices &
Instruments list from the Devices tab in Windows98 (the
Advanced tab in Windows95). 

Driver Configuration

At any time, you may reconfigure your BiPort 2x4s Windows driver
setup.  To do so, from the Windows98 (or Windows95) Start menu, select
Settings | Control Panel | System | Device Manager | Sound, video
and game controllers | Midiman BiPort 2x4s | Midiman Driver Setup.  

The “COM Port” listbox allows you to select the COM port that is con-
nected to the BiPort 2x4s unit.  For proper operation, this setting must
match the actual COM port that is connected to the BiPort 2x4s.

The “Configure Input Connection” section allows you to operate the
BiPort MIDI inputs in the typical fashion, or merged together into one
stream.  As of this writing, most commercially available MIDI programs
will accept the default setup, which makes the BiPort 2x4s look like 3
MIDI input devices:  MIDI In-A, MIDI In-B, and SMPTE In (Sync/Status
information).   On the other hand, some older commercial and some
shareware MIDI applications can only handle one MIDI stream.  In this
case, select “Merge All.”
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IMPORTANT:  Only select the “Merge All” feature if your
MIDI application allows only one input to be selected at a
time in its MIDI setup.  The “Merge All” can affect SMPTE
sync performance adversely because the MIDI Time Code
(MTC) from the SMPTE port must be merged with any other
MIDI data that is coming in on In-A or In-B.  This incoming
MIDI data can “jitter” the MTC and make the timing look
irregular to the receiving MIDI application.

Mac Driver/OMS Installation

The BiPort OMS Driver is designed to run with Opcode’s “Open Music
System.”  You will need the OMS application to use the BiPort 2x4s as a
multiport MIDI device.  If you do not have Opcode’s OMS installed, or if
you are not using an application that supports OMS, you will not be able
to use the BiPort 2x4s.  This is available as a free download from
Opcode’s website, and you will find a link to it on the drivers page of
the Midiman website.

To Install the BiPort on your Mac, first attach one side of the supplied
Mac serial cable (or any standard Mac serial cable) to the jack labeled
“Host In,” and the other side to either the printer or modem port on you
computer (for more information, consult the sections of the manual
titled “BiPort Installation” and “BiPort to Host Connection”).

Make sure that OMS has been successfully installed.  After you are sure
that OMS is properly installed, go to the Control Panel or Chooser under
the Apple Menu, and make sure AppleTalk is turned off  (this is recom-
mended, although OMS will sense that it is on and prompt you to turn it
off).  

Mac Driver Installation

If you are installing your BiPort driver and configuring OMS for the first
time, follow these instructions to configure OMS.  If you have a studio
setup already created in OMS and wish to create a new studio setup,
skip to the section below entitled “Installing with an existing Studio
Setup.”  
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First Time OMS Configuration Instructions

1. Insert the supplied disk entitled “BiPort 2x4s Mac Drivers.”  Have
your System Folder open, with the OMS Folder accessible.  Double
click on the floppy disk icon when it appears and drag the BiPort
OMS Driver icon into the OMS Folder.

2. Within your Hard Drive files, find the Opcode folder.  In the Opcode
folder, find the OMS Applications folder, then OMS Setup.  Double
click on OMS Setup.  

3. OMS will inform you that it has not yet been configured.  Click OK.  
4. The Create A New Studio Setup dialog box now appears.  Click OK.
5. The “OMS Driver Search” box asks you to choose the port on which

you’ve attached the BiPort (either Modem or Printer).  Choose a port,
click “Search.”  OMS begins Searching.

IMPORTANT: At this stage of the BiPort OMS setup you
MUST have the Mac Thru switch on the BiPort in the Out
(MIDI) position.  If this switch is In, the BiPort is bypassed,
won’t be seen by OMS, and setup will fail.  Also, if the serial
cable is not correctly hooked up to the BiPort, setup will
fail.

6. “OMS Driver Setup” now shows the BiPort (and the port to which it is
attached) in a list when OMS successfully finds the driver.  Click OK.
OMS will now define (shows “Identifying”) all of the BiPort output
ports.  Please note that OMS sees the BiPort ports A through D as
ports 1 through 4 (this is an OMS idiosyncrasy).  

7. The “OMS MIDI Device Setup” dialog box will appear showing the
BiPort’s four available output ports with open check boxes to the left
of each port.  You will now have to check all of these open boxes to
enable each of the output ports.  Now click on OK.

8. Next, the “My Studio Setup” appears with a file save dialog box over
it.  You will now need to name and save your new Studio Setup
before you can assign various instruments to the BiPort’s outputs and
inputs.  Assign your various instruments and you are done.  You may
now exit OMS Setup by quitting the application.  
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Installing with an Existing Studio Setup

If a Studio Setup already exists using another device, or if you want to
create a different setup for different studio configurations using the
BiPort:

1. Follow steps 1 and 2 of the “First Time OMS Configuration
Instructions” installation procedure given above.

2. Open OMS.  The current Studio Setup will appear.  Drop down the
File menu and go to “New Studio Setup.”  The “Create a New Studio
Setup” dialog box appears.  Click OK.

3. Continue with steps 5 through 7.
4. Next, the file save dialog box appears.  If you want to save this setup

as an alternative to previous studio setups, you will need to name it
something other than the name of your existing setup, such as “My
Studio Setup 2.”  After doing this, you can then assign your specific
instruments to the BiPort Ports inputs and outputs.

Remote Control Software

Included with your BiPort 2x4s are both Windows and Macintosh
Remote Control software that enable you to configure and control the
BiPort 2x4s SMPTE functions from your computer.  The software enables
you to set user bits, frame format, flywheel and write start time (offset),
as well as start and stop SMPTE writing.  Different Remote Control soft-
ware settings may be saved to disk as “configurations” and reloaded at a
later time.

Remote Control Windows Installation

To install the BiPort 2x4s Remote Control application into Windows,
insert the Midiman BiPort 2x4s diskette into your disk drive. Next,
under the Windows Start menu select Run... . When prompted to enter a
command line, type either A:SETUP.EXE if your diskette is in drive A, or
B:SETUP.EXE if your diskette is in drive B.  Next, select the OK button.
The SETUP program will automatically guide you through the installa-
tion and create a MIDIMAN group with a BiPort 2x4s Remote Control
icon.

By default, the Remote Control setup program installs the BiPort Remote
Control to C:\Program Files\Midiman\BiPort Remote.  You might want
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to create a shortcut to it that you can place on your desktop.  To do this,
open the Windows Explorer by Start | Programs | Windows Explorer.
Under the C drive list, click on the plus sign next to Program Files, click
the plus sign next to Midiman, and then click the BiPort Remote folder.
In the list of Contents (the right column of Explorer), right click on the
file named Bpremote and select “Create Shortcut.”  This will create a
shortcut file in the Contents list that you can then click and drag to your
desktop.

Remote Control Operation

If you haven’t worked with SMPTE/MTC sync before, we suggest you
read the section SMPTE/MIDI Time Code Tutorial before reading this
section just to familiarize yourself with some basic ideas and terminolo-
gy.

SMPTE Setup

The primary screen of the BiPort Remote Control Software gives you
complete control over all the SMPTE sync functions of the interface.

The controls are fairly self-explanatory. Format sets the SMPTE frame
rate for the BiPort SMPTE generator. Flywheel sets the number of frames
the reader/regenerator will automatically advance and correct when
receiving either bad or no time code.  Slide the Flywheel slider towards 0
to set “Jam Sync” mode.  The Start Writer button starts and stops the
SMPTE writer.  The Start Time and User Bits buttons allow you to set,
respectively, SMPTE start time and the outgoing User Bits.
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Click on the arrows next to each number to change them to match the
start time you want to use. 

Change these numbers to match your desired user bits settings. The
<Tab> key will move you to the next field.

Menus

Following are brief explanations of the program menu choices.

File
Load Config

Retrieve a previously saved SMPTE configuration.  A “factory” configu-
ration is included during program installation.  If the Save current con-
figuration before loading new one box is checked, the current configura-
tion file will be automatically overwritten with the current settings.  If
the Save current configuration before loading new one box is not
checked, you can lose your current configuration if you haven’t previ-
ously saved it.  Be careful.
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Save Config

Save the currently active SMPTE configuration. All aspects of the
SMPTE settings (start time, user bits, etc.) are saved with the configura-
tion file.

Delete Config

Delete a SMPTE configuration from the provided list.

Confirm Exit

If this is checked, you will always be asked to confirm that you actually
want to quit the program (a good choice for people who are mildly para-
noid about losing any of their work). On the other hand, if you are irri-
tated by the confirmation dialog and don’t want to be re-asked each time
you choose to exit the program, uncheck this selection.

Exit

Quit the program. If the Confirm Exit option is checked (see above) the
program will have you confirm that you want to quit before it actually
closes.

Hardware
Current Status
This selection gives you the current status of the BiPort MIDI drivers,
and displays whether or not the BiPort hardware is present and detect-
ed.  The BiPort internal firmware revision is also displayed here if the
BiPort is present and detected.
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SMPTE Test

This selection gives you the current status of the SMPTE reader. This
pop-up dialog will tell you whether or not the BiPort is currently locked
to SMPTE and what the incoming SMPTE format is. This feature is very
handy if you are experiencing SMPTE synchronization problems.  If
unable to lock onto an incoming SMPTE signal from this dialog box, you
should check your SMPTE connections and SMPTE source. 

Help
About

The usual information: what the program is, what version, who wrote it,
copyright notice, etc.

Remote Control Mac Installation

Included with your BiPort 2x4s is Remote Control and Diagnostic soft-
ware that enables you to configure and control your BiPort 2x4s SMPTE
functions directly from your computer, as well as a diagnostic test for
basic BiPort functionality.  This software enables you to set User Bits,
frame format, flywheel, and write start time (offset), as well as start and
stop SMPTE writing.   Different Remote Control software settings may
be saved to disk as a “Setting” and recalled or reloaded at a later time.

To install the BiPort 2x4s Remote Control & Diagnostic application onto
your Macintosh, first insert the disk entitled “BiPort 2x4s Mac Drivers &
Remote Control Software” into your floppy disk drive.  When the disk
icon appears, double click on it.  Next, locate the file “BiPort Remote”,
click on it and drag it onto your hard drive.  Double clicking on the
BiPort Remote application from your hard drive will then open the
BiPort 2x4s Remote Control.

Remote Control Operation

If you haven’t worked with SMPTE/MTC sync before, we suggest that
you read the section of the BiPort manual entitled “SMPTE/MIDI Time
Code Tutorial” beginning on page 28.

The primary screen of the BiPort Remote Control Software gives you
complete control over all of the SMPTE sync functions of the interface.

The controls are fairly self-explanatory.  Format sets the SMPTE frame

31



rate for the BiPort SMPTE generator.  Flywheel sets the number of
frames the reader/regenerator will automatically time out on and cor-
rect when receiving either bad or no time code (slide the Flywheel fader
towards 0 to set “Jam Sync” mode).  The “Start Writer” button starts and
stops the SMPTE writer.  The Start Writer button will change to “Stop
Writer” after it has been clicked to begin writing.  The “Start Time” and
“User Bits” buttons allow you to set, respectively, SMPTE start time and
the outgoing user bits.

To Set SMPTE Frame Rate

Click the button next to the SMPTE frame rate that you wish to use.  The
LEDs on the BiPort front panel to the right of the Format button should
reflect these changes.  

Note: A frame rate of 29.97 will light the “30” fps LED.
Remember, selecting a frame rate of 29.97 only effects the
rate at which 30 non-drop is written and has no effect on
SMPTE reading.  When reading SMPTE, programs or prod-
ucts will normally display this frame rate as 30 non-drop
since they usually cannot tell the difference between 30
non-drop and 29.97 .

To Set Flywheel

Click on the slide fader and drag it until the desired setting is reached.

To Set SMPTE Start Time

The SMPTE start time defaults to 1 hour.  To change the SMPTE start
time, click on the box that contains the start time settings.  Highlight the
numbers in the area you wish to change (Hours, Minutes, etc.) and enter
the desired start time values.  The “Tab” key will move you to the next
field.  Click OK when you are finished selecting the new start time.

To Set User Bits

User Bits are set to all zeros as the default.  To change the user bit setting,
click on the User Bits box.  Highlight the User Bits area you wish to
change (there are eight bits that can be encoded with information) and
enter the desired single digit.  The “Tab” key will move you to the next
field.  Click on OK when you have created the desired setting.
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Menus

Following are brief explanations of the program menu choices.

File|New Setting

When the BiPort Remote Control is first opened, the default setting is
“BiPort Preferences.”  Clicking “New Setting” in the file menu will reset
all Remote Control settings to their defaults, while bringing up a new
setting configuration entitled “New Configuration.”

File|Open Setting

If you have saved a configuration setting previously, Open Setting will
bring up a dialog box that will allow you to choose the saved setting.
Locate the setting you wish to load (you may want to create a folder to
store several saved settings) highlight it and then open it by clicking
“Open.”

File|Close

This option is grayed out while in Remote Control mode.  It is accessible
when using the BiPort diagnostics and can be used to close the diagnos-
tics when you are through.  Clicking the square in the left corner of the
diagnostic box will also close it.

File|Save Settings or File | Save As

If you have changed remote Control settings and wish to save them to
be recalled at a later date, open the file menu and click “Save.”  This will
bring up a dialog box that asks you to name the file and then click
“Save.”

“Save As” should be used to save an existing file under a different name.
Opening the File menu and clicking “Save As” will bring up the same
dialog box that asks you to name the file, then click “Save.”

File|Revert To Saved

If you’ve opened a file and changed settings, yet wish to switch back to
the original file that you had opened, then open the File menu and click
“Revert To Saved.”  This will reset the Remote Control to previously
saved settings.
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File|Save As Default

Opening the File menu and clicking “Save as Default” will take the cur-
rent file that is open and its settings and make it the current default set-
tings file.  Opening the BiPort Remote Control in the future will bring up
this new default, still using the name “BiPort Preferences.”  Quitting the
application will then ask you if you want to save the changes under a
new name.  Choosing to do so will save the settings to another file name.
Choosing “Don’t Save” will still bring up those changed settings as the
default “BiPort Preferences.”

File|Quit

Choosing File|Quit will exit the application.

The Edit Menu

Cut, Copy, and Paste are accessible from the Edit Menu.  These can be
used for offset values or user bit values and will remain in the clipboard
while moving from file to file within the application. 

The Hardware Menu

Clicking on “Current Status” will display the OMS version that is in use,
plus the BiPort’s firmware revision number.  Clicking “SMPTE Test” will
display the SMPTE time seen at the input as well as the frame rate that is
being detected.  This is useful when reading and/or regenerating
SMPTE.

The Select Menu

This menu allows the user to select between the Remote Control and the
Diagnostic test.  Running the application opens up the Remote Control,
so clicking on “Diagnostic” from the Select menu will then open the
Diagnostic test.  Clicking one or the other from the Select menu will
bring that window to the forefront.  See section “Running the
Diagnostics.”

Help 

The Help menu will allow you to either show or hide “Balloon” help.
One can also select “About Balloon Help” for information about
Balloons. 
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Configuring Applications to Use BiPort 2x4s

Once the drivers for the BiPort 2x4s have been installed, you will need to
configure your MIDI applications to take advantage of the BiPort 2x4s
drivers.  The manner in which each application does this is different, so
it is impossible to go over all possible scenarios here. However, most
Windows MIDI applications have a MIDI configuration or settings dia-
log box (sometimes called “MIDI Devices” or “MIDI Tools”) that speci-
fies the MIDI input and output devices the program will be communi-
cating with.  If your BiPort 2x4s drivers are properly installed, you
should see the BiPort 2x4s MIDI and SMPTE ports listed in this dialog
box.

In its factory default configuration, the BiPort 2x4s looks like eight inde-
pendent devices, 3 of which are inputs and 5 are outputs. From the
application’s configuration dialog, these devices are:

Inputs
BiPort 24s Input A
BiPort 24s Input B
BiPort 24s Sync/Status

NOTE: If the inputs are set up in the driver to be merged, you will see
only one BiPort MIDI input device: “BiPort 24s In A+B+S”.
Outputs
BiPort 24s Output A
BiPort 24s Output B
BiPort 24s Output C
BiPort 24s Output D
BiPort 24s Control

Inputs A and B correspond to the physical MIDI In connectors A and B,
and the SMPTE/Status corresponds to the 1/4” SMPTE Input connector.
Outputs A through D correspond to the physical MIDI Out connectors A
through D, and the SMPTE Control corresponds to the SMPTE processor
command port.  Although the SMPTE/Status driver transfers time code
data (MIDI Time Code to be specific) into the program, the SMPTE
Control driver does not actually transfer SMPTE data out of the pro-
gram.  Instead, it is used by applications like the Remote Control to con-
figure and control (Start Writing, Stop Writing, User Bits, SMPTE format,
etc.) the processor that resides inside the BiPort 2x4s. If you wish to
transmit MTC through the BiPort, do it through one of the MIDI output
devices.
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In order to route data between the application and specific ports on the
BiPort 2x4s, select (from within your application) the appropriate drivers
of the above list.  Many newer applications (Cakewalk Pro Audio for
Windows, for example) will allow you to select and access all the BiPort
2x4s ports within the same session.  Other applications will limit the
number of input and output drivers you may select at one time - for
instance, Master Tracks Pro 6.0 can only handle two MIDI ports at a
time.

SMPTE/MIDI Time Code Tutorial

This section gives a brief tutorial on various SMPTE topics. This section
is not by any stretch of the imagination an exhaustive treatment of time
code or syncing. Instead it is included to make the BiPort 2x4s SMPTE
functions more understandable.

What is SMPTE (Time Code)?

SMPTE is a time coding standard, which was developed in 1967 by the
Society of Motion Picture and Television Engineers (SMPTE) to be used
in video editing. SMPTE attaches a unique time stamp (80 bits of infor-
mation) to each frame of video or film.  SMPTE readers may then extract
that time information and synchronize other devices to it.  Because
SMPTE may be encoded as an actual audio signal, it also lends itself to
audio applications and can be read from audio tracks for synchroniza-
tion purposes.

The SMPTE Time Code consists simply of:

Hours : Minutes : Seconds : Frames.

Therefore a typical SMPTE time code reading would be:

01 : 25 : 42 : 17

which represents the time 1 hour : 25 minutes : 42 seconds : 17 frames.

The original SMPTE Time Code was Longitudinal Time Code (LTC).
“Longitudinal” means that the code is laid down in a continuous audio
stripe along the length of the tape (longitudinally). The BiPort 2x4s is
designed to write this longitudinal time code (LTC) as well as read and
convert it to MIDI Time Code (MTC).
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What is MIDI Time Code (MTC)?

MIDI Time Code (MTC) is the MIDI implementation of SMPTE.  MTC
was first standardized in 1987 as a method of synchronizing MIDI soft-
ware and hardware sequencers, as well as drum machines.  Later it was
also adopted by digital audio recording software and hardware manu-
facturers as a method of synchronizing to audio and video gear.
Interfaces such as the BiPort 2x4s perform the essential task of reading
longitudinal SMPTE from an audio and/or video tape and converting it
to MTC for use by MIDI applications. 

MTC implements a special System Common MIDI message that is sent
four times per frame (every quarter-frame).  Each of these “quarter-
frame” messages is two bytes long and contains one eighth of a com-
plete time code value. A unit or program receiving MTC must receive
eight of these messages in order to construct the complete time.  By the
time 8 quarter-frame messages are received and the complete time is
constructed, that time value is two frames old and it would seem that
any synchronized application would always be two frames behind.
Fortunately, most sequencer programs add two frames to the received
MTC in order to derive the current time.
As long as a longitudinal SMPTE source is running, time code may be
read.  However, what happens when it stops?  The LTC is no longer
readable and the BiPort 2x4s sends a standard MTC NAK (signal not
acquired) message to the application to indicate the tape has become
idle.  

About Frame Rates

All SMPTE time code and MTC carries the same primary information,
Hours:Minutes:Seconds:Frames. However, SMPTE time code can be
written and read at different standard frame rates. These frame rates
designate the number of frames that each second is subdivided into.
Different video, film and audio standard frame rates have been adopted.
These various standards and typical applications are:

Frame Rate Application
24 frames/second Motion Pictures (film)
25 frames/second European Video - both B/W & Color
30 drop frame U.S. Color Video
29.97 frames/sec. U.S. Color Video
30 non-drop U.S. B/W Video and U.S. Audio
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Black and white video frame rates were originally derived from the A/C
line frequency of the indigenous country (e.g. 50 Hz in Europe, 60 Hz in
the U.S.).  In the U.S. when color video was introduced, part of the black
and white frame information was used to encode the color information.
The result was that the color frame rate ran at an effectively slower rate
of 29.97 frames per second. This slower rate can be approximated by
running at 30 frames per second and skipping 108 frames per hour in the
numbering scheme.  This method of “dropping” 108 frames/hour to
slow the effective frame rate was termed “drop frame.”  Hence, the stan-
dard frame rate used when doing U.S. color video is called “30 drop
frame”.  When running at a true 30 frames per second, this is known as
“30” or sometimes “30 non-drop”.

As listed in the above table, in the U.S. and other “NTSC” countries,
black and white (30 non-drop) and color (30 drop) video have different
frame rates. While in Europe and all “PAL” countries, black and white
and color video have the same frame rate of 25 frames per second.

What Frame Rate and Settings Should You Use?

The following table summarizes the frame rates that we recommend you
use when striping SMPTE: 

Application Frame Rate
Audio Only 30 non-drop
Video - Color U.S. 30 drop*;  29.97
Video - B/W U.S. 30 non-drop
Video - Color Europe 25
Video - B/W Europe 25

Note: If you are in the U.S. and using a BiPort 2x4s to do
audio scoring or MIDI sequencing for your own video, then
we suggest you use 30 non-drop instead of 30 drop. This is
because drop-frame is harder to work with, since time cal-
culations are more complicated.  Non-drop will allow you to
sync just as well drop-frame; drop-frame is really only a
necessity for broadcast purposes.

SMPTE and MTC User Bits

The SMPTE and MTC standards provide a means for users to “stamp”
their media with reference numbers of their own choosing.  This is
accomplished by setting aside some spare data (32 bits) within the time
code message to be used as “User Bits.”  SMPTE and MTC allow you to
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encode these User Bits into the time code message without affecting the
time code itself.

Because there are 32 User Bits available, they can be further subdivided
into 8 nibbles (one nibble = 4 bits), each of which can represent a binary-
coded decimal (BCD) digit.  A typical set of User Bits might look like
this:

0 4     1 9     0 3     1 2 

This could be interpreted as April 19, shot 03, take 12. Although this is
one method of encoding user bit information, you may designate the
digits in any way that you desire.

Many inexpensive sync boxes ignore User Bits because they have no
way to set them or read them. The BiPort 2x4s User Bits can be set via
the Remote Control software and may be displayed with some outboard
device such as the MIDIMAN SMPTE Time Window.  The User Bits are
also transmitted via MIDI message to the MIDI application that you are
using. If your sequencer is capable of displaying User Bits information,
then you may read the User Bits there as well.

The BiPort 2x4s is capable of reading and writing SMPTE User Bit
groups U1 through U8. The values of the User Bits output during writ-
ing may be set with the Remote Control software. When reading User
Bits from an incoming source, a MIDI User Bits message is sent to the
application each time sync is acquired and whenever a change in User
Bits is detected.

SMPTE Offset

An “offset” is the starting time of the first frame of time code and may
be set to any time value in the range 00:00:00:00 through 23:59:59:29.
Usually, you can set your offset to any value in this range, but some-
times the production environment will dictate the offset requirements.
The BiPort 2x4s has a default write offset of 01:00:00:00. If you need to
change the offset time, you may do so via the supplied Windows
Remote Control software.

IMPORTANT:  Try to avoid high offsets that may wrap
around (from 23:59:59:29 back to 00:00:00:00).  Some pro-
grams become confused by this wrap-around.  Choose an
offset that will allow your entire session to be striped with-
out rolling over the  24:00:00:00 time code value.
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At times, you may be given a tape with SMPTE already on it.  The offset
time on the tape you receive will affect the start time that you set for
your MIDI sequencing. For example, if the time code on the tape starts at
02:00:00:00 (a 2-hour offset) and you need to start your sequence playing
3 minutes, 30 seconds into the work, you should set the sequencer start
time to 02:03:30:00.

Because MTC requires 8 quarter-frame messages to send a full frame of
time code, a minimum of 2 to 4 frames will be needed for a sequencer to
first sync up to a running SMPTE.  Therefore, when syncing a MIDI
sequencer or any program to time code, it is a good idea to set your
sequence start time to a few seconds later than the offset of the time code
on tape. In other words, give your sequencer some time to acquire sync
and stabilize before it begins playing back.  For example, if your tape
starting offset is 01:00:00:00, then set the sequence start time to
01:00:05:00, which is 5 seconds later.  This is also known as a 5-second
pre-roll.  Some sequencers will actually allow you to directly set the
“pre-roll” time to a specific number of seconds. These programs will
automatically sync up to an incoming MTC source for that pre-roll
amount, and then start playing.

Flywheeling

Due to the nature of magnetic tape, sometimes drop-outs occur on the
tape and leave gaps in the recorded time code. When a drop-out or other
media corruption occurs at the sync source and there is a resulting peri-
od of corrupted time code, the BiPort 2x4s continues to “flywheel,” out-
putting time code from the last properly received frame and increment-
ing at the proper frame rate. This flywheeling continues until valid time
code reappears on the BiPort 2x4s SMPTE input or until a preset time-
out occurs. The length of this time-out period is called the “Flywheel
Time.” The BiPort 2x4s flywheel time may be set to any amount from 1
to 255 frames, or infinite. It is good practice to use the shortest Flywheel
setting that will work with the amount of drop-out found on the media
you are syncing to. Infinite flywheeling is also known as Jam Sync and
may be used to continue generating time code long after the time code
source has expired.

Syncing to SMPTE 

Recording a SMPTE Stripe (Writing SMPTE)

Before the BiPort 2x4s can be used to synchronize to a source audio
and/or video tape, that tape must be encoded with SMPTE time code.
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Sometimes you will be provided with a piece of source material that
already has SMPTE on it. In that case, you are not required to record
another SMPTE stripe and may instead read the SMPTE as is. If, on the
other hand, your source material has no current time code encoded you
will need to record your own SMPTE time code to one of the tape’s
tracks. This is commonly known as “striping the tape.”

To record a SMPTE stripe onto tape, follow these steps: 

1. Use the Remote Control software to set the BiPort 2x4s frame rate to
the appropriate SMPTE format, as discussed in the About Frame
Rates section of this manual. We recommend you select 30 non-drop
for audio, 25 for European (PAL) video, and, unless you are scoring
for commercial release, 30 non-drop for U.S. (NTSC) video. 

2. From the Remote Control software, set the SMPTE offset time to the
desired value. SMPTE offset is displayed on a large button and press-
ing this button will allow you to adjust the offset. If no special offset
is required we recommend you use 01:00:00:00 (one hour). Some
users want their audio to start exactly on an even hour boundary —
if that’s your desire, set the offset to something like 00:59:55:00 which
will allow 5 seconds of pre-roll before your sequence starts at
01:00:00:00. 

3. Optionally, you may now set the “User Bits.” User Bits are not a
mandatory requirement and if you don’t need to set them, the BiPort
2x4s will default to standard User Bit settings. User Bits are displayed
on the large button to the right of the offset button and pressing this
button will allow you to adjust the bits.

4. On your tape or video deck, choose the audio channel you will be
striping to. Make sure that the BiPort 2x4s SMPTE Out is firmly con-
nected to the proper Tape In or Sync In of your tape deck. When
choosing an audio channel on a multichannel deck, pick one of the
end channels (e.g. Channel 8 of an 8-track machine). This will mini-
mize cross-talk between the time code and the other audio tracks of
the tape.

5. Put your tape deck into record/pause mode. If you have a deck with
a varispeed adjustment, make sure it is zeroed.

6. Click on the “Start Writer” Button in the Remote Control software.
The BiPort will start outputting SMPTE time code.

7. Adjust your recording level to between -10 and -5 dB. You want
enough gain to make a good clean recording, but if the recording is
too “hot”, time code noise may bleed over to other tracks. Also, make
sure noise reduction such as DBX or Dolby is defeated. When writing
or reading SMPTE, the data may be corrupted by noise reduction and
the results may be unacceptable. We recommend that you do NOT
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use noise reduction when recording or playing a SMPTE sync track.
8. Click on “Stop Writer” to stop the SMPTE code. You are now set to

begin recording the SMPTE stripe.
9. Take the tape deck out of pause. Allow the tape to pre-roll for at least

10 seconds. This pre-roll gives the tape transport time to stabilize and
get past the most dropout-prone area of the tape, the beginning. Click
on the “Start Writer” button to start generating time code.

10. Continue recording several minutes of SMPTE stripe. Naturally, you
will need a stripe that is longer than the piece you are going to sync.
It is safer to record a stripe that is too long than too short — you can
always record over the end of a long stripe.

11. When done recording the stripe, click on the Remote Control soft-
ware’s “Stop Writer” button to stop generating time code.

12. Take your tape recorder out of record. 
13. Rewind your tape to just before where you started recording the sync

stripe.

That’s it-that’s all there is to recording a SMPTE stripe. You now have a
SMPTE stripe to sync to. 
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Syncing to a SMPTE Stripe

With a SMPTE stripe recorded on one track of your tape deck, you are
now ready to sync to tape. Set your sequencer to SMPTE/MTC clock,
making it a slave to the BiPort 2x4s. Since the BiPort 2x4s auto-detects
the frame rate of incoming SMPTE, it is not necessary to set the frame
rate of the BiPort when syncing.  However, you may need to set your
sequencer program to the proper incoming SMPTE format.

Note: The BiPort 2x4s always stores its current configura-
tion when you exit Windows. Therefore, when you restart
Windows, the BiPort 2x4s recalls its last setup and you do
not have to modify it unless you want to change parameters
such as frame format or User Bits.

Make sure the BiPort 2x4s SMPTE In is connected firmly to the
Tape/Sync output of your tape deck.

From your sequencer, you should select the BiPort 2x4s SMPTE Input as
one of your input devices. Some sequencers will automatically detect
MTC streaming in from this port and sync to it. Others, such as Master
Tracks, require you to designate which input port MTC is coming in on.
If this is the case, make sure that you designate “BiPort 2x4s SMPTE In”
as your sync input.

In all sequencers you must set a SMPTE start time at which the sequence
will start playing. This sequencer start time, if not dictated by post pro-
duction requirements, should be set to a value at least a few seconds
greater than the SMPTE offset you used to stripe your tape with. For
example, if your recorded SMPTE stripe started at 1 hour you should
use a sequencer start time of at least 1 hour and 5 seconds. This small
additional time (pre-roll) gives your sequencer a couple of seconds to
lock to SMPTE and stabilize before it has to start playing.

If all of this is done correctly, and you start playing your tape, your
sequencer should start playing exactly at the set sequencer start time.
Your sequencer should stay in perfect sync with the tape, even if you
have a varispeed deck. If you fast-forward and then start playing your
tape your sequencer should “chase lock” exactly to the SMPTE on the
tape.
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Trouble-Shooting

If you are having problems using your BiPort 2x4s, it is probably a good
idea to re-read this manual and make sure you have properly installed
the interface. If you can’t find the source of your difficulty then check the
following typical fixes:

Interface Trouble-Shooting

SYMPTOM: The diagnostic program’s Internal Hardware Test reports
“FAIL — Interface Not Found.”
SOLUTION 1: The Serial Port, IRQ and/or Address settings in the
diagnostic program probably do not match the actual IRQ and Address
setting of your serial port.  Set them to the correct value(s). 
SOLUTION 2: Make sure the BiPort is properly connected to your
computer, and to the proper COM/Serial port. If your PC COM port is
conflicting with your modem, try the other COM port. For Macs, the
modem port is more desirable than the printer port.

SYMPTOM: The diagnostic program’s Transmit/Receive Test fails.
SOLUTION: Either you forgot to install the MIDI loopback cable, or
the ports you’ve physically looped-back have not been properly speci-
fied in the diagnostic program.  This test transmits MIDI data out one
port and then verifies that it can be properly read into another.

SYMPTOM: The diagnostic program’s SMPTE I/O Test fails.
SOLUTION: You may have forgotten to connect the board’s SMPTE In
connector to the SMPTE Out connector using a 1/4” phone cable. This
test uses the cable to write SMPTE back into the unit and verify that it
can be properly read.

SYMPTOM: The diagnostic program passes all tests except for the
“Receive Interrupt” test.
SOLUTION: The IRQ setting in the diagnostic program probably does
not match the IRQ setting of your serial port. Make sure they are set to
the same value. If this does not alleviate the problem then your port is
probably using another IRQ than you think it is, or you have another
peripheral using the same IRQ (See the Installation and Diagnostics sec-
tions).

SYMPTOM: My computer can’t find the interface when I run my
sequencer program. 
SOLUTION 1: You don’t have the Windows driver properly installed,

44



or the driver is not installed at all. Turn back a couple of pages and fol-
low the instructions for Windows Driver Installation.
SOLUTION 2:  The sequencer program is not set up to use the BiPort
driver. This must be done from within the program itself.  Make sure the
BiPort input and output devices are selected for use by your sequencer
program.

SYMPTOM: The unit works fine with some of my programs but does-
n’t work with others.
SOLUTION: There is probably a set-up problem with the program that
isn’t working.  It is likely that you haven’t selected the BiPort driver
from within your application.

SYMPTOM: The BiPort 2x4s driver is properly installed but I’m not
getting any sound when I run my sequencer.
SOLUTION 1: Your Windows application must select the BiPort 2x4s
as its MIDI Input and Output device. This is done from within the appli-
cation itself.
SOLUTION 2: The BiPort does not produce sound.  Instead it connects
to external MIDI devices that do produce sound, like a MIDI synthesizer.
Make sure that external MIDI device is properly set up and connected to
the BiPort.
SOLUTION 3: The driver may be disabled.  Go to Settings | Control
Panel | System | Device Manager, then open up the list under “Sound,
video and game controllers” by clicking on the “+” sign.  Highlight the
BiPort, click Properties, and then click the Midiman Driver Settings tab
to view the settings that you have selected.  If the COM port is set to
“Disable,” then select the proper COM port.

SYMPTOM: My keyboard shows “MIDI Data Error,” or “MIDI Buffer
Full”. 
SOLUTION: Check your MIDI cables and MIDI connections. Be sure
the cables are plugged in all the way. If the problem persists try new
cables. 

SYMPTOM: MIDI is being sent and received properly but when I play
my sequencer it lags and bogs down.
SOLUTION: Make sure you don’t have a MIDI feedback loop. Try turn-
ing the “Local Control” on your keyboard to OFF if it is being used both
as a controller and as a sound module.  A MIDI feedback loop can also
occur if the MIDI Out of the interface is somehow connected back to the
MIDI In through some external device. This can be avoided by turning
off the MIDI Thru on either your keyboard or in the application soft-
ware.
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Syncing Trouble-Shooting

If you are having trouble syncing to SMPTE you should check the fol-
lowing:

Are you using a high quality tape deck and tape?  Have you tried using
a higher quality Metal or Chrome Tape?

Do you have the BiPort 2x4s SMPTE In connected to the proper Tape
Out/Sync Out port of your deck? 

Are your SMPTE audio cables good? 

Have you discovered the best Input and Output level settings on your
tape deck?  You may need to spend some time playing with different
playback and record levels to find the best and most reliable settings. If
the signal is too hot or too low during record or playback you may
encounter problems.  You should play with the record and playback lev-
els until you get reliable sync.  We have found that a level of around -10
dB is best.

A SMPTE stripe is essentially data recorded to tape.  If your recorder
uses noise reduction, such as DBX or Dolby, when writing or reading
SMPTE, the data may be corrupted and the results may be unacceptable.
We recommend that you do NOT use noise reduction when recording or
playing a SMPTE sync track.

If you are recording any kind of a sync stripe and going through a mix-
ing board to set levels, make sure any EQ is off or flat.  If you EQ a
SMPTE signal it may turn to mush.  Also, try to avoid the bussing sys-
tem by using direct outputs.

Are you trying to use SMPTE mode with a sequencer that does not sup-
port MTC or is not set to chase to MIDI Time Code? 

With all sequencers you must set a SMPTE song/sequence start time.
Make sure you set this SMPTE start time to a value at least a couple sec-
onds later than what your SMPTE stripe starts at. For example, if you
recorded a SMPTE stripe starting at 1 hour (01:00:00:00), you should set
your sequencer start time to something like 1 hour and 5 seconds
(01:00:05:00).
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Make sure your sequencer is set to receive MTC on the Windows driver
that has MIDI Time Code coming over it. This driver is called “BiPort
24s Sync/Status”.

If the SMPTE can be heard on neighboring tracks (i.e. there is cross-talk),
then try striping the tape at a lower level. The BiPort 2x4s SMPTE wave-
form is specially designed to limit cross-talk (per the SMPTE specifica-
tion). However, if it is recorded “too hot”, the signal could bleed into
other tracks just as any other audio signal could.

BEFORE CALLING TECH SUPPORT

It is best to be in front of the computer in which you are installing the
BiPort 2x4s when attempting to reach Midiman Technical Support for
help.  

Have the computer powered up, with the BiPort 2x4s Drivers and
Diagnostics Disk and this manual close by.  

Please be ready to identify which Midiman product you have, and to
concisely explain what the problem is that you are encountering.  

Take a deep breath, then dial the Tech Support number listed on the back
of the manual or email at the address listed.  

Tech Support hours are 9AM to 5PM Pacific time, Monday thru Friday.
There is no best time to call, but persevere and you will get through to a
human being who will be eager to help you.  

Expect email answers within 24 to 36 hours.
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Lifetime Limited Warranty

MIDIMAN warrants that this product is free of defects in materials and
workmanship under normal use so long as the product is owned by the
original purchaser and that purchaser has registered his/her ownership
of the product by sending in the completed warranty card.

In the event that MIDIMAN receives written notice of defects in materi-
als or workmanship from such an original purchaser, MIDIMAN will
either replace the product, repair the product, or refund the purchase
price at its option. In the event any repair is required, shipment to and
from MIDIMAN and a nominal handling charge shall be born by the
purchaser. In the event that repair is required, a Return Authorization
number must be obtained from MIDIMAN. After this number is
obtained, the unit should be shipped back to MIDIMAN in a protective
package with a description of the problem and the Return Authorization
clearly written on the package.

In the event that MIDIMAN determines that the product requires repair
because of user misuse or regular wear, it will assess a fair repair or
replacement fee. The customer will have the option to pay this fee and
have the unit repaired and returned, or not pay this fee and have the
unit returned unrepaired. 

The remedy for breach of this limited warranty shall not include any
other damages. MIDIMAN will not be liable for consequential, special,
indirect, or similar damages or claims including loss of profit or any
other commercial, damage, even if its agents have been advised of the
possibility of such damages, and in no event will MIDIMAN’s liability
for any damages to the purchaser or any other person exceed the price
paid for the product, regardless of any form of the claim. MIDIMAN
specifically disclaims all other warranties, expressed or implied.
Specifically, MIDIMAN makes no warranty that the product is fit for any
particular purpose.

This warranty shall be construed, interpreted, and governed by the laws
of the state of California. If any provision of this warranty is found void,
invalid or unenforceable, it will not affect the validity of the balance of
the warranty, which shall remain valid and enforceable according to its
terms. In the event any remedy hereunder is determined to have failed
of its essential purpose, all limitations of liability and exclusion of dam-
ages set forth herein shall remain in full force and effect.
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